
HOUDINI FOUNDATIONS 
DESTRUCTION FX 
One of the things that makes visual effects fun is that you get to blow things up without causing any real 
damage. In this lesson, you will light a fuse using particle sparks then explode a cartoon bomb using rigid 
body dynamics for the shell of the bomb and Pyro FX for the fire and smoke. This lesson will teach you how 
to set up dynamic simulations using a variety of shelf tools and network nodes.
To give you a complete understanding of the shot being developed, you will build all the elements from 
scratch, then simulate the effects. This will help you understand how the simulation nodes work within the 
wider context of a Houdini scene. In the end, you will render out the shot using the Karma renderer. 

LESSON GOAL
Model then blow up a bomb using particle sparks, rigid body dynamics and Pyro FX.

WHAT YOU WILL LEARN
	� How to model the bomb and animate the fuse
	� How to animate a camera to set up the shot
	� How to set up a particle soot trail and sparks for the fuse
	� How to shatter then explode the bomb geometry
	� How to set up a Pyro FX simulation for the explosion
	� How to set up materials and textures
	� How to render the effects with Karma in the Solaris context

LESSON 
COMPATIBILITY
Written for the features in Houdini 19.5+

The steps in this lesson can be 
completed using the following 
Houdini Products:

Houdini Core ✘

Houdini FX ✔

Houdini Indie ✔

Houdini Apprentice ✔

Houdini Education ✔

Document Version 1.0 | July 2022
© SideFX Software

ACES | OPENCOLORIO SETUP
For more accurate color display when working with Pyro 
FX, you should use the Academy Color Encoding System 
(ACES). To use it, bring up the Correction Toolbar from the 
viewport (persp) menu in the scene view.  From the arrow button on the right, choose OpenColorIO. This 
will give you a Display of sRGB and an output of SDR Video - ACES 1.0. This setting only works for your 
current session and will need to be turned back on each time you open Houdini.
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PART ONE
Model the Bomb
To create the bomb geometry, start with a primitive sphere and modify it to define the opening at 
the top. This will involve a few poly extrudes and bevels to define the geometry you will need for 
the final shape. Later in the lesson, you will fracture the bomb.

01 Select File > New Project.  Change the Project Name 
to destruction_lesson and press Accept. This creates a 

project directory with sub directories for all the files associated with 
this shot.

Select File > Save As... You should be looking into the new 
destruction_lesson directory. Set the file name to destruction_01.hip 
and click Accept to save. 

02 In the viewport, press c to bring up a radial menu. From 
this menu, choose Create > Geometry > Sphere. In the 

viewport, press Enter to place it at the origin. In the Operation 
Control bar at the top, set Radius to 0.3, 0.3, 0.3.

Press s to get the select tool then 3 to invoke edge selection. Press 
Spacebar 2 to go to a Top view. Box select the edges at the top and 
bottom of the circle and press delete. This dissolves the edges and 
leaves two circular polygons in their place Press Spacebar 1 to go 
back to a perspective view.

03 Press s to get the select tool then 4 to switch to primitive 
(face) selection. Select the circular polygon at the top of 

the sphere. 

Press c to bring up the radial menu and select Model > Polygons > 
Polyextrude. Move the handle up by a Distance of about 0.075. Set 
Output Front to Off.

04 Select the circular polygon at the bottom of the 
sphere and press Delete. This will add a blast node 

to the network. Press s to go to the Select tool and 3 to change 
to edge selection. Double click on the edge of the hole you just 
created to select all the edges.

Press tab > Polyfill. In the Parameter pane, set Fill Mode to 
Quadrilateral Grid and Smooth to 270. This creates a cleaner 
topology for the bottom of the sphere that doesn’t go to a 
single point.
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06 Press s to go to the Select tool and 3 to change to edge 
selection. Double click on the edge at the top of the 

bomb and then press Shift and double click to select the inner 
circle at the top.

Press c to use the radial menu to go to Model > Polygons > 
Polybevel. Set Distance to 0.005. Set the Shape to Round and 
Divisions to 3.

07 Press s to go to the Select tool. Double click on the edge 
where the circular part of the bomb meets the extruded 

section at the top.

Press q to repeat the last tool which was Polybevel and set 
Distance to 0.01, Shape to Round and Divisions to 3. 

08 In the Network view, press tab > Transform and add it 
to the end of the network. Set  Translate Y to 0.3 and 

Rotate X to around 27 degrees. 

Add a Null node. Wire the end of the polybevel to the null then set 
the display flag on the null node to display it. Double click on its 
name and change it to BOMB_OUT.

Go to the Object level and rename the object to bomb_geo since it 
holds the bomb’s geometry. 

SURFACE NORMALS
Every primitive has a normal direction where one side is the inside and 
one is the outside. When you polyextrude the bomb geometry it will be 
inside out at first. This is indicated with the blue color on the faces. You 
can then use a Reverse node to redirect the normals.

You can see the normals on the surface using the Display Primitive 
Normals button found in the Display Options bar on the right side 
of the Scene view pane. 
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05 Press n to select all Faces and again get the Polyextrude 
tool.  Extrude to a Distance value of around -0.04. In the 

Parameter pane in the Extrusion tab, turn on Output Back.

Press n to select all Faces and again press tab and start typing 
Reverse. This node reverses all the polygon normals. Now they are 
pointing in the right direction.



TOOL HINTS
The curve tool comes with tool hints that display in the Scene view as 
you work. These provide different shortkey options for this tool and 
help you get familiar with how it works. 

You can collapse it using Shift + F1 and only the tool name will display. 
There are a growing number of tools that use tool hints and you will see 
more of them in future versions of Houdini. 

PART TWO
Model the Fuse
To create the Fuse, start with a Bezier curve that emerges from the top of the bomb. You can then snake the 
curve on the ground to create a longer fuse. Reverse the curve direction to get ready for animating the fuse 
then add a Polywire node to give the fuse thickness. 

01 Press spacebar-b to see the bomb from all angles. Move 
over the Right view and press spacebar-b to expand it. 

Press c to bring up the radial menu and choose Create > Geometry 
> Curve. Click drag up to create the first point and tangent handle 
for the curve. Next add a point and drag down to quickly draw the 
curve pointing down.

02 Press x and choose Grid to turn on grid snapping. Click 
and drag on the ground to create a third point with its 

tangent handle aligned along the ground.

03 Press spacebar-b to go back to 4 views then mouse over 
the perspective view and press spacebar-b again expand 

the view. 

Turn off Grid Snapping then turn on the Construction 
Plane using the second button at the top of the Display 
Options bar. This will make sure that any edits you make 
stay on the ground. 

Draw three new points with their tangents dragged out to define 
the curve’s shape.

MMB-click to complete the curve.
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05 In the Scene View, press tab > Reverse. Press n to select 
the whole curve and press Enter.  Since the curve was 

drawn from the bomb out, it will not animate in the direction you 
need. This will put the start of the curve where the fuse begins. 

06 Turn on the Display Points option in the 
Display Options bar. Add a Resample node. 

On the resample node, set the Maximum Segment 
Length to 0.025 to add more detail. The resample node 
evens out the points. 

07 Add a Polywire node to add thickness to the wire. Set 
the Wire Radius to 0.0075 and the Divisions to 8. 

Between the reverse and polywire nodes, add a Transform node. Go 
to the polywire node and RMB-click on the Wire Radius parameter 
and choose Copy Parameter. Now go back to the transform 
node and RMB-click on Translate Y and choose Paste Relative 
References. 

This will lift the whole fuse up so that it is not halfway under the 
ground grid.

08 Add a Blast node Set Group to 0. This deletes the end of 
the fuse geometry. Next add a Normal node to the end 

of the chain.

After the normal node, add a Null node and name it FUSE_OUT. 
This gives you a node representing the whole fuse geometry.

Go back up to the object level and rename this object to fuse_geo.

04 In the Operation Control bar, change the curve Mode to 
Select/Edit. Now you can click on the edit points on the 

curve and make changes to refine the shape of the curve. 

Select and edit the points on the ground to get the desired look for 
the curve.  Tumble around to make sure that your curve stays above 
the ground plane.
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02 Go to frame 180. Set First U to 0.999. This will set a 
keyframe. You can see that the fuse will. Go to frame 

200. Set First U to 1.0. This will set another keyframe.

In the bottom left of the Playbar, toggle realtime playback on so 
that it doesn’t play back too fast and press Play.

The fuse now animates into the bomb geometry where you will set 
up the explosion. 

03 Click on the Animation Editor Pane tab. Select the 
animation curve and click on the Straight button at the 

top of the panel. This will straighten the curve and the fuse will 
animate evenly from start to finish instead of speeding up then 
slowing down at the end.

Go back to the Scene View pane tab and playback the animation to 
see how this change affects the motion.

Save your work.

04 In the Network View, add a Sphere node and set its 
Display Flag. Set the following:
	� Radius to 1, 1, 1
	� Center Y  to 0.0075
	� Uniform Scale to 0.0075

Press Spacebar-F to focus on it. 
	� Orientation to Z Axis  
	� Rows to 9 and Columns to 8 

In the Scene view, press n to select all then tab>Clip node and set 
its Direction to 0, 0, -1. 

01 Dive back into the fuse_geo object. Between the 
transform node and the Polywire node add a Carve node. 

Drag on the First U slide to see how this affects the curve.

Set First U to 0. Alt click on First U to set a keyframe at frame 1. 
The parameter box will change color to indicate that it has been 
keyframed and that there is a key at the current frame.

PART THREE
Animate the Fuse
Animate the fuse using a Carve node that lets you control the length of the curve over time. Add a round cap to the fuse that 
will be used to emit soot and sparks. You need to set up tangents on the curve to ensure that the cap follows along properly. 
Next add some NULL objects to make it easier to export the cap for use in emitting particles. 
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06 Add a Copy to Points node into the network. Feed the 
polyfill node from the sphere into the first input and the 

carve node into the second input. Set Target Points to 0. 

Add a Merge node. Feed the blast node and the copytopoints node 
into it then wire it into the normal node.

The cap it positioned properly at the end of the curve but it isn't 
oriented correctly. You need to add normals to the curve to allow 
for proper alignment.

07 Add a Orientation Along Curve node between the 
reverse and the carve nodes. Under Output Attributes 

turn off the Y Axis option. Leave Tangent (Z axis) set to N. This adds 
normals to the curve that will align the end cap as it moves along 
the fuse.

08 Add a Color node after the polyfill node and set the Color 
to yellow. Add another Color node after the fuse’s blast 

node and set its Color to Dark Gray. These colors will be helpful for 
visualizing the fuse as you work and can also be used to affect the 
materials being assigned later. 

05 Tumble around and press s to get the select tool and 4 to 
get face/primitive selection. Select one of the triangles at 

the tip of the sphere then press and hold the a key and then middle 
click two triangles over to select all the triangular faces. Press the 
Delete key to remove them. This adds a blast node to the network.

Press 3 to go bring up edge selection then double click on the edge 
of the area you just blasted. Press tab > polyfill which places the 
node after the blast. Set Fill mode to Quadrilateral Grid then turn 
on its Display flag. Set Smooth to 100 and Tangent Strength to 0. 
This will create quad topology at the tip of the sphere.  

09 Branch off a Null node after the copytopoints node and 
place it to the side. Name the null node CAP_OUT. You 

will use this later to extract the cap into another network that you 
will reference to emit particles. Set its Display Flag to see only 
the half sphere. You can scrub the Playbar to see it move with the 
carve.

When you are finished, set the Display Flag back to the FUSE_OUT 
null.
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02 On the Curve node, turn on the Z Axis option and set 
it to N. This will create normals that will assist with 

animation along the curve.

03 Add a Null object at the origin. Rename this node 
camera_lookat_null. From the Constraints shelf, click on 

the Follow Path tool. This accepts the null as the starting object. 
Select the curve as the path object then press Enter. Press Enter 
twice more since you don’t need a look-at object or a look-up 
object. 

Now if you scrub in the timeline, you can see that the null object is 
moving along the Path from the first frame to the end frame at an 
even pace.

04 A constraint network was added to the null object and a 
path node is created. Go to frame 1. With the Path node 

selected, RMB click on the Position parameter and choose Delete 
Channels to remove the expression that is animating the null along 
the path. Set Position to 0. Alt click on Position to set a keyframe. 

Go to frame 195 and set Position to 1. Alt-click on Position to set a 
second keyframe.

Click on the Animation Editor tab and press h to see the whole 
curve. Select it and press the Straight button to make it linear. Grab 
the tangent on the second point and adjust to smooth out the end. 

01 Dolly out to see the whole scene from above.  Make 
sure the construction plane is on. Press c to bring up the 

radial menu and choose Create > Geometry > Curve. Click-drag 
a point near the start of the fuse and drag forward to extend the 
tangent. 

Next, click-drag a second point behind the bomb and drag to pull 
out the tangent to create an s shaped curve. MMB-click to finish 
and use Select/Edit mode if you want to tweak the shape.

PART FOUR
Create an Animated Camera
As you develop this shot further, it would be helpful to have a camera set up to frame the final shot. This camera rig will be 
built by constraining a null object to a curve then using an aim constraint to point the camera to the null object. This will give 
you a camera that follows the end of the fuse to make it easier to evaluate the particles as they are being emitted.

1

2

Straight Curve Drag Tangent Handle
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07 Go to Frame 1. Select the camera and make sure the 
Handle tool is active. This brings up a camera handle 

which you can use to reposition the camera to have a better view 
of the fuse's starting point. 

Go to Frame 195. Use the same handles to reposition the camera 
to make sure the bomb in nicely positioned in the frame.

You may need to scrub back and forth to tweak the camera to work 
properly throughout the sequence. Make sure you can see the fuse 
throughout the whole sequence.  

08 Go to the object level and select the curve, camera_
lookat_null object and cam1 node and align them then 

put them into a network box.  Double click on the box’s title bar 
and name the box Camera Rig. Turn off the display of all the parts 
so that you don’t see them in the scene view as you work. You can 
collapse this box if you want or keep it open if you want to work 
with it further. 

Save your scene.

06 From the Constraint shelf, click on the Look At tool. This 
will use the selected Camera as the look at object. Select 

the null object as the look at object and press Enter. Press Enter 
again to not assign anything as the look up object.

Now the camera is looking at the Null object. From the Camera 
menu, select cam1 to look through this camera.

05 In the Network view, press tab > Camera and press Enter 
then click to place it at the origin. Now use the Move tool 

to move it in front of the fuse and a bit to the right. Next move it up 
along the Y axis to raise it from the ground by about 0.75 units.

CONSTRAINTS
To get the null object to follow the path and then to get the camera to look at the path, 
you used animation constraints found on the Constraints shelf. The are accomplished 
using a special node type called Channel Operators or CHOPS. You can find these 
nodes inside the null and camera nodes. You can use these to control how the con-
straints work.

Another way to work with CHOP nodes is to use the Motion FX menu that you find 
when you RMB-click on any parameter.  

1 Move Along Z

2 Move Along X

3 Move Up
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02 Dive into the soot_trail node and add a POP network 
node to the end of the chain. Dive in and on the Source 

First Input node, set Const Birth Rate to 1000. Press Play. You can 
see particles being emitted but they aren’t doing anything.

Go back up one level and on the Simulation tab, set Substeps to 3. 
Press Play. You can see particles being emitted more evenly.

03 Alt-drag on the object_merge node to make a second 
copy. Set Object 1 to the fuse_geo>resample node. You 

are going to use this curve to transfer velocity onto the cap.

Now add a Orient Along Curve node and under Output Attributes 
turn on Tangent (Z Axis) and set it to v.

Add an Attribute Transfer node between the original object_merge 
and the popnet node. Turn off the Primitives checkbox and set 
Points to v.

04 Place an Attribute Adjust Vector node in between the 
attributetransfer and the popnet. Under Adjustment value 

set the following:
	� Adjustment for to Direction Only
	� Adjust with to Noise
	� Range Values to Zero Centered
	� Amplitude to 0.5

Under Noise Pattern set Element Size to 0.025 and under Post 
Process, turn on Enable Post-Process. Press Play to test.

01 Dive back into the fuse_geo object node. With the display 
flag on CAP_OUT, go to the Modify shelf and use the 

Extract tool. Press n to select all the faces then press Enter to 
create a new object with the Cap being imported using an Object 
Merge node. Go up to the object level and name this object soot_
trail.

Go back to the fuse_geo object and set the display flag to FUSE_
OUT. Now you will see the combined fuse geometry when you 
render and the new object will be used to generate particles.

PART FIVE
Create a Soot Trail
To create a soot trail, use the end cap to emit a trail of particles. Learn how to emit these points properly and how to add forces 
such as gravity to control the motion of the particles. Learn how to set up collisions where the particles either stick to the 
ground or slide off the bomb surface.
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05 Dive back into the popnet and add a Gravity Force node 
under the popsolver. Now if you play the simulation the 

particles fall below the ground.

08 Jump back up to the geometry context and wire the 
popnet into an attribute create node. Set Name to pscale 

and Value  to 0.001. 

Add a Color SOP and set the Color to dark grey.

Add a null to the end of the chain and name it SOOT_OUT.

07 Right now the particles will be emitted throughout the 
whole sequence. You need them to stop them just as the 

bomb explodes. Add a POP Kill node after the wire_pops_into_here 
merge node. Go to frame 1. Set Activation to $F>199. This will kill 
the particles at frame 200.

Now under the Rule tab, turn on Enable. Press Play to test.

06 Go back up to the Object level and create a grid. Set size 
to 30, 30 and Rows and Columns to 31, 31. 

Rename this to ground. Go back into the popnet and add a Pop 
Collision Detect node after the source_first_input node. Set the SOP  
Path to the obj/ground/grid1. On the Behavior tab, set Response 
to Stick. Keep Color Hits set to Red. 

Add another Pop Collision Detect node. Set the SOP to the bomb_
geo geometry object. Set Response to Slide. Change Color Hits to 
Green. Press Play.

PARTICLE FX
The soot trail is created using particle dynamics. Particles are points that you can  
affect using forces such as wind or gravity. Starting with the end of the fuse, you 
give birth to points that are then simulated using a number of different techniques. 

Particles are simulated using the Dynamics or DOPS section of Houdini then 
brought back into SOPS where you can work with them as geometry. In the next 
section, you will use particles to create sparks at the end of the fuse.

117

Create



 a

 S
oot


 

Trai


l



02 Dive into the sparks object. You will make a few changes 
to get the network set up to create sparks.

Delete the atttributecreate and color nodes. These are not needed 
for this particle network. Rename the null node to SPARKS_OUT.

On the attributeadjustvector node change Amplitude to 1.75.  

Add a new Attribute Adjust Vector node above this one. Turn on 
Enable Pre-Process and set Constant Value to 0, 1, 0. Now the 
particles will rise up before dropping down. Press Play.    

03 Got Frame 1. Add an Attribute Adjust Float node just 
before the popnet node. Set the following:
	� Attribute Name to life
	� Unit Settings to Duration
	� Pattern Type to Random.
	� Min Value to 2 and Max Value to 4
	� Under Random, set Seed to $F

01 Go to frame 1 then navigate to the Object level. Hide the 
Ground object. Alt-drag on the soot_trail  object to make 

a copy. Name the copy sparks. 

This new object already has a popnet and can be modified to 
generate the spark particle simulation. In Houdini, it is often a good 
idea to re-use a network you already have as opposed to building 
everything from scratch.

PART SIX
Create Particle Sparks
To create sparks, start by copying the soot particle object and make changes to the new object to generate sparks. These par-
ticles will have shorter lifespan and will be more active. The Spark Trail node will give you the look you need to add sparks to 
the shot. You can adjust parameters on this node to get the look you need. 

SPARKS | PARTICLE TRAIL
The Particle Trail SOP takes an animated particle system and generates 
motion trails from its particles. These trails can be used for various effects 
such as sparks, fireworks, and rain. 

This node also allows you to control the look of the trails. This enables 
you to fine-tune their look in the SOP context, without the need to render 
the points with large amount of motion blur.

118

H
O

U
D

IN
I F

O
U

N
D

AT
IO

N
S 



05 Go back up to the Geometry level. Go to frame 1. 

In the Network view, press tab > Spark Trail. After a short 
delay, this will put down two nodes - a timeblend and a sparktrail 
node.  Wire the popnet into the timeblend node and the sparktrail 
into the SPARKS_OUT null.

Press Play. You will see sparks but they will be lagging behind by 
the end of the fuse. 

08 Go to frame 1. Jump up to the Object level. 

Set the camera to cam1 and press the Flipbook  button 
on the bottom of the toolbar. Click Start on the window that pops 
up. This will create an animated sequence of the scene view that 
you can use to evaluate the motion of your particles.

Make sure the Realtime toggle  is on and playback the flipbook 
to see how the shot is progressing.

07 Go to frame 1. Select the sparktrail node. Click on the 
Split tab and turn on the Enable Split checkbox. Set 

Percent to Split to 40.

Under Shape, set Splits per Point to 4. 

Press Play to test.

06 Add a Time Shift node after the object_merge which 
brings in the cap and the attributetransfer node. Click 

on the Frame parameter name to see the expression being used. 
Change it to $FF + 1

This will move the cap forward a frame but at the same time align 
the sparks with the end of the fuse. Press Play to test.

04 Dive into the popnet and delete the two collisiondetect 
nodes. You will not need to worry about collisions at this 

point. You will add other nodes back later when needed. 

Press Play to see the particles being emitted.                  
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04 Under Adjustment Value, set the following:
	� Adjustment for to Direction Only
	� Operation to Spread
	� Adjust with to Noise
	� Spread Angle Min to 15
	� Spread Angle Max to 120

Under Noise Pattern set Element Size to 0.5.

Under Post-Process turn on Post Process then turn on Length 
Scale and set it to 20.

02 On the fracture_solver node, set Start Frame to 200. Now 
set the start frame in the Playbar to 200. Click the First 

Frame button to go to frame 200. You will only need to simulate 
the explosion from frame 200 to 240. 

On the fracture_solver node go to the Collision tab in the Ground 
Collision section, set Ground Type to Ground Plane.  Click on the 
Advanced tab then in  the Constraints >Glue section, remove the 
word Glue from the Data Name field.

Press Play to watch the bomb fall apart. Now you want to add a 
starting velocity to explode the parts.

03 Go to Frame 200. Add an Attribute Adjust Vector node 
and place it to the right of the other nodes. Wire the 

third output of the rbd_configure node into the attributeadjustvector 
node then wire the attributeadjustvector node into the third input 
of the fracture_solver node.

Set the following on this node:
	� Turn on Enable Pre-Process
	� Turn on Overwrite Initial Value
	� Initial Vector to 0, 1, 0

01 Hide the fuse_geo, soot_trail, and sparks objects. Press 
Spacebar-G to focus on the bomb geometry. Go to 

Frame 1 in the Playbar. Press Spacebar G to focus on the bomb.

Select the bomb_geo object and from the Simple FX shelf, select 
Simple Fracture. When asked to Select Collision Object just press 
Enter with nothing selected. It will then take a short time to set up 
this network. This object merges out the bomb geometry and sets 
up nodes for fracturing and simulating.

PART SEVEN
Blow up the Bomb
For the bomb geometry, a rigid body dynamics simulation will be needed. Start by fracturing the geometry then adding  
attributes that will create an explosion. You can then control the speed of the moving parts to art direct the look. Once the  
simulation is ready, you will cache out the geometry to work more efficiently as you move on to the PyroFX stage. 
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09 Add a Null node and wire the first output of the fracture_
io node into it. Rename this node EXPLODING_BOMB_

OUT.  

07 Select the rbdmaterialfracture node and under Cell Points 
set Scatter Points to 25. Press Play. Now you have a lot 

more pieces. 

Go back to the attributeadjustvector node and set Length Scale to 
50 and Initial Vector to  0, 5, 0. Press Play. 

08 Go to frame 200. On the fracture_io node, set Base 
Name to exploding_bomb and Base Folder to $HIP/geo/

bomb. Click Save to Disk which will then turn on Load From Disk. 
Press Play to preview the cached geometry.

06 Select the rbdconfigure node. Open up the Speed Limit 
section and turn on the Speed Max and Spin Max 

parameters. Set Speed Max to 2 and Spin Max to 30. Press Play. 
The simulation slows down a lot from its original speeds. 

Now set Speed Max to 10 and Spin Max to 60. Press Play. 

05 Press Play. Now you have the bomb exploding. Setting 
velocity attributes on the geometry feeds into the 

simulation which uses the initial velocity of the pieces to propel 
them forward. 

The manipulation of attributes plays a bit role in many visual effects 
setups in Houdini.
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PART EIGHT
Create the PyroFX Explosion
As the bomb explodes there needs to be an accompanying fireball. You will start with a Simple Fireball that works on the GPU 
then make changes to create a look that works for the shot. You can also incorporate the parts of the exploding bomb to push 
and influence the PyroFX volume in interesting ways. 

03 Go to frame 200. On the pyroburstsource node go to the 
Burst Shape tab and set Initial Size to 0.35 and Spread 

Angle to 180.

Now go to the fireball Pyro Solver node and click on the Bound 
tab and set Size to 15, 12, 12 and Center to 0, 4, 0. This will make 
a smaller box which will fit better on the GPU. On the Setup tab, 
set the Voxel Size to 0.035 - this will add more detail to this smaller 
simulation. 

Press Play to test the simulation. Now the explosion fits better in 
this scene.

01 Go to the Object level. From the Simple FX shelf, click on 
Simple Fireball. In the Scene view, press Enter to place it 

at the origin. This creates several nodes inside a fireball object. 

Set the Display Flag on the pyroburstsource node and on the Burst 
Animation tab, set Start Frame to 200. Go to frame 200. This node 
represents the initial blast of the explosion.   

From the Quick Setup menu, choose Single Input Point. This adds 
a single point. Use the transform handle to raise it up to around 0.3 
which is the middle of the bomb geometry. 

 

02 On the pyrosolver_fireball node, change Start Frame 
to 200. Set Simulation Type to Minimal OpenCL to 

simulate using your GPU. 

Under the Sourcing tab, open the Limit Source Range option and 
set the Frame Range to 200, 240. Turn off Cycle Length. 

Set the Display Flag on the RENDER_Simple_Fireball null node. 
Zoom out to see more of the scene then press Play to test the 
simulation. The Fireball is very big. Zoom out to see the whole 
explosion.

04 The next step is to integrate the Pyro FX with the 
exploding bomb. Add a File node and load the $HIP/geo/

bomb/exploding_bomb.$F.bgeo.sc geometry sequence from disk. 
Wire this node into the second input of the fireball Pyro Solver 
node. 

Press Play to test the simulation. The collision geometry isn’t having 
an effect because it hasn’t been prepared properly.
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09 Set the Display Flag on the pyrolook node. This is the 
Pyro Bake Volume node that can be used to visualize 

the simulation in the Scene View.  It is designed to provide a similar 
interface to the Pyro Shader you will use later when rendering.

Under the Smoke tab, darken the Smoke Color then under the 
Scatter tab set Intensity Scale to 2500.  Make other adjustments to 
get a look that you like for your simulation.

07 Between the fireball Pyro Solver node and the pyrolook 
node, insert a Pyro Post Process node. Turn on the 

Convert to VDB and the Convert to 16bit Float checkboxes. Next 
turn on the Cull Volume and Resample Volumes options and leave 
them both set to vel.  

This node will make your volume more efficient and save you disk 
space when you cache your volume.

08 On the fireball Pyro Solver node click on Quick Setups 
and choose Cache Simulation. Move the node to the 

side then wire the pyropostprocess node into the sim_fireball cache 
node then wire the cache node into the pyrolook node. Set Base 
Folder to $HIP/geo/pyrosim/ then click Save to Disk.

Now with the Load from Disk option set to on, you can scrub in the 
Playbar to see the PyroFX explosion.

06 Between unpack and vdbfrompolygons, add a Peak node 
to make pieces bigger. Set Distance to 0.1. Between the 

peak node and the vdbfrompolygons node, add a Attribute Adjust 
Vector node. Turn off Adjust Value and turn on Enable Post Process 
then turn on Length Scale and set it to 2.

Set the Display flag back to the fireball node. From the Collision 
tab, open the Limit Collision Range section and set Range Type to 
Frame Range and Frame Range to 200, 240. Turn off Cycle Length. 
Press Play to test the simulation. The exploding bomb is now 
colliding with and influencing the Pyro FX simulation.

05 Go to frame 200. Select the fireball node. From the 
Quick Settings menu in the top right, choose Setup SDF 

Collision. This adds a vdbfrompolygons node. This node gets it’s 
Voxel Size from the Pyro Solver node.

Add an RBD Unpack node between the file and vdbfrompolygons 
nodes. 

Add an Unpack node between the rbdunpack and vdbfrompolygons 
nodes. On the unpack node, set Transfer Velocity to v. Set the 
Display Flag on vdbfrompolygons then press Play to see the collision 
geometry.
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04 Add a USD Export node to the end of the chain. Rename 
it static_bomb. Set the following
	� Valid Frame Range to Render Current Frame 
	� Output File to $HIP/usd/static_bomb.usd

Press Save to Disk.

02 Go to the Select tool then press 3 to select Edges. Press 
w to go into wireframe mode and then press Shift and 

double click to select part of the loop at the bottom. Press Shift and 
double click to select all four parts. Repeat for the inner loop.  

Now go to the loop on the top of the inner sphere and press Shift 
and double click to select. Now pick the latitudinal line that aligns 
with the X axis and press Shift and double click to select.  

In the Scene View, press tab > Group. Change the Group Name to 
uv_edges. 

03 In the Scene View press tab > UV Flatten which adds 
a uvflatten node after the group node. Set Seams to 

uv_edges and under Layout Constraints, turn off Enable Manual 
Layout. This provides a good looking UV layout that will be perfect 
for texturing the bomb.

Set the Display Flag on the BOMB_OUT null node.

01 Go to the Object level and hide the fireball object. 
Double click on the bomb_geo and set the Display Flag 

on the second polybevel node. This shows you the bomb geometry 
before it was rotated into place.

Set the Display to Hide 
Other Objects to stay 
focused on the contents of 
this network.

PART NINE
Export the Geometry to USD
To set up the shot for rendering, you need to export the geometry to USD files that can be referenced into the Solaris context. 
While you could import the geometry directly, having it cached out as USD will allow you to lock down your sequences then 
focus on lighting and rendering in Solaris. For some of these objects, you will add UVs before exporting to prep for texturing.

Inner Loop

Bottom Loop

Inner Loop

Longitudinal 
Loop
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07 Go back to the Object level then double-click on the 
ground network. After the grid node, add a UV Project 

node and set its Display Flag. Go to the Initialize tab and press the 
Initialize button. On the Transformation tab, change Scale X to -1, 
Scale Y to 1 and Rotate Y to -90.

This will allow the texture to repeat on the ground surface rather 
than create one large texture,

06 After the attributedelete node, add a Normal node. This 
will help the bomb geometry display properly in Solaris.

Add a USD Export node to the end of the chain. Rename it 
exploding_bomb. Set the following

	� Valid Frame Range to Render Frame Range 
	� Output File to $HIP/usd/exploding_bomb.usd 

Press Save to Disk.

05 Go back to the Object level then double-click on the 
bomb_geo_fracture network. Select the fracture_io node 

and press Save to Disk to cache out the geometry with the new 
UVs. You won't see them yet because the geometry is packed.

After the fracture_io node and before the EXPLODING_BOMB_OUT 
node, add an Unpack node then an Attribute Delete node. On the 
attributedelete node, enter name next to Primitive Attributes.  Turn 
off the Point Attributes section.

This ensures that the sequence comes into Solaris as a single mesh. 
The name attribute would break the sequence into individual parts.

08 Add a USD Export node to the end of the chain. Rename 
it ground. Set the following
	� Leave Valid Frame Range set to Render Current Frame 
	� Output File to $HIP/usd/ground.usd 

Hit Save to Disk.
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USD and SOLARIS
To support the look development stage of this project, layout, lookdev and lighting 
workflows are set up in the Solaris context. This is represented by LOP networks. The 
USD caches you are creating here will go into the Solaris context. 

You will reference the USD caches into the LOP network using this scene file but in a 
larger pipeline another option would be to start a new scene file and import the USD 
files in a fresh scene. This would let you focus on lighting and rendering your shot but 
would make it harder to go back and tweak the geometry and simulations.



11 Go back to the Object level then double-click on the 
sparks network.  

Add an Attribute Create node to the end of the chain. Set the 
Name to width and the Value to 0.0005. This will determine the 
look of the sparks when they are rendered.

Add a USD Export node to the end of the chain. Rename it sparks. 
Set the following

	� Valid Frame Range to Render Frame Range 
	� Output File to $HIP/usd/sparks.usd 

Hit Save to Disk.

10 Go back to the Object level then double-click on the soot 
network. Add a USD Export node to the end of the chain. 

Rename it soot_trail. Set the following
	� Valid Frame Range to Render Frame Range 
	� Output File to $HIP/usd/soot_trail.usd 

Hit Save to Disk.

09 Go back to the Object level then double-click on the 
fuse network. Add a USD Export node to the end of the 

chain. Rename it fuse. Set the following
	� Valid Frame Range to Render Frame Range 
	� Output File to $HIP/usd/fuse.usd 

Hit Save to Disk.

12 Go back to the Object level then double-click on the 
fireball network.  From the sim_fireball node, branch off a 

USD Export node. Be sure to bypass the pyrolook node. Rename it 
pyro_fireball. Set the following

	� Valid Frame Range to Render Frame Range 
	� Output File to $HIP/usd/pyro_fireball.usd 

Hit Save to Disk.
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Scene Import
Another way to get your geometry and simulations into Solaris is using 
the Scene Import LOP. This creates a direct connection between the 
geometry and objects you are working with and the LOP network. This 
approach would require cache LOPs to support motion blur which is an 
extra step not needed if you are referencing in USD files. 

This tool is going to be used to bring the animated camera from the  
object level into the Solaris context.



04 In the Network View press tab > Reference then click to 
add a reference node. Next to Reference Pattern, click on 

the File Chooser and find the sparks.usd file. Rename the node to 
sparks. Set the Primitive Path to /fx/$OS.

Alt -drag on this node to make a copy. Name it soot then point the 
File Chooser and find the soot_trail.usd file.  Add a Merge node to 
bring these files together then feed them into the main Merge node 
and set it's Display Flag. If you scrub in time, you will see the sparks 
and the soot persist after they were killed. The USD file holds onto 
the particles right until frame 240. 

02 Alt-drag on this node to make three copies. Name them 
exploding_bomb, ground and fuse then point the File 

Chooser parameter to these USD files. 

Feed these into a Merge node and set its Display Flag. After the 
static_bomb node, add a Prune LOP. Set the Prune parameter to 
$F >200.  After the expoding_bomb node, add another Prune LOP. 
Set the Prune parameter to $F <199.  Now when you scrub in the 
Playbar, the bomb will switch between the static and exploding 
bomb at frame 200. 

03 Press tab > Scene Import (Cameras). Place down 
this node and wire it into the merge node. Set the 

Destination Path to /cam/. This adds any camera found at the 
object level into the Solaris context. 

Go to the camera menu choose cam1 to look through this animated 
camera. Make sure you have the merge node selected. Scrub in the 
Playbar to see the fuse and the exploding bomb animate and then 
explode through the lens of the camera you set up at the object 
level. If you were to make changes to that camera it would be 
reflected here in Solaris.

01 Go back to the Object level. Press tab > LOP Network to 
create a subnetwork to use to set up your shot. Name it 

destruction_stage. Double click on the node to dive into it.

Change the desktop to Solaris. Make sure you see obj > destruction_
stage in the Scene view’s path bar. Press D over the scene view and 
go to the Background tab and set Color Scheme to Dark.

In the Network View press tab > Reference then click to add 
a reference node. Next to Reference Pattern, click on the File 
Chooser and find the static_bomb.usd file. Rename the node to 
static_bomb. Set the Primitive Path to /geo/$OS.

PART TEN
Set up the Shot in Solaris
Learn how to reference all of the USD files into Solaris then import the camera from the object level. Apply materials  
to all the elements and start rendering with Karma to evaluate the results. Learn how to add a key light and prepare render  
settings to explore the final look of the shot.
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07 Go back up one level and add an Assign Material node 
to the end of the chain. From the Scene Graph, drag 

static_bomb and exploding_bomb to the Primitives field. 

Now click on the arrow next to Material Path and select the bomb_
mat. Press the plus sign to add more sections and repeat these 
steps to assign materials to the fuse, sparks and soot. 

Assign the concrete Material to the ground.

06 Add a Material Library node after the merge node. Go to 
the Material Palette and drag a Principled Shader and a 

Concrete Shader into /stage/materiallibrary. 

Go to the Network view and rename the principled shader to 
bomb_mat. Alt drag to make three copies of the principled shader 
and call them fuse_mat, sparks_mat and soot_mat. 

05 After the effects merge node, add a Prune LOP. Set its 
Display Flag. Set the Prune parameter to $F >199.  Now 

the soot and sparks disappear at this point.

09 In the Scene view, select Karma from the Persp menu. 
Turn off the Reference Plane.  

Go back into the Material Palette and select the concrete 
shader.  In the Texture section, set Effect Scale to 0.01.

Turn on the Denoiser in the side bar. This will use your 
graphics card (nVidia cards only) to more quickly resolve 
the noise in your rendering. 

08 Go to around frame 180. Click on the Light tool in the 
LOP Lights and Cameras shelf. This adds a light to your 

shot and has you looking through it. 

Go to the Base Properties tab and set Intensity to 50.

In the Scene View, click on the Shadow button and click on the 
surface of the bomb then Shift click behind it to create a shadow.

128

H
O

U
D

IN
I F

O
U

N
D

AT
IO

N
S 



12 Select the sparks_mat shader and under Emission set the 
following:
	� Emission Color to 1, 1, 1 [white]
	� Emission Intensity to 10
	� Turn on Use Point Color

This will make the sparks shine brighter and even create a bit of 
illumination on the ground surface.

11 For the fuse_mat and soot_mat shaders, set the Base 
Color to a Dark Grey. 

On the fuse_mat shader turn off Use Point Color to allow the Base 
Color to control the look. 

10 Select the bomb_mat shader. Under Surface, set the 
following:
	� Base Color to Black [0, 0, 0]
	� Roughness to 0.7

Under Displacement, turn on Enable Noise Displacement and set 
the following:

	� Noise Type to Alligator Noise
	� Frequency to 30, 30, 30
	� Amplitude to 0.01
	� Roughness to 0.8

13 Go back to the Stage level. In the Network View, press 
tab > Karma to add a Karma Render Settings and USD 

Render ROP node. Wire them into the end of the chain. Select the 
karmarendersettings node and set Primary Samples to 32. On the 
Image Output > Filters tab set Denoiser to nvidia Optix Denoiser 
to turn the denoiser back on.

On the Advanced tab, go to the Sampling section and set 
Convergence Mode to Path Traced.
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RENDER SETTINGS
The Karma Render Settings node adds render settings that become part 
of the Scene Graph and will be used to render to the viewport and to disk.

Before you added these settings the viewport settings were being used 
when you rendered in the viewport. If you have Karma rendering set up in 
the Scene view then Press D to see these settings. If you have render set-
tings in your Scene Graph then they will override the viewport settings. 



04 Select the materiallibrary node and click the plus sign 
next to Number of Materials. Click on the Operator 

chooser button next to Material VOP on the new listing and 
navigate into the fireball object then into the lopnet_fireball then 
into the matnet to select the Pyro_Shader. Click Accept.

Even though this material is in a different LOP network, it can be 
referenced from its location to this materiallibrary node.  

02 Navigate back to the Object level then into the fireball 
object. Select the pyrosolver_fireball node. From the 

Quick Setups menu, select Create Render Stage. This adds lopnet_
fireball into this network. You can dive into it to see the suggested 
setup. You could use this to render the fireball on its own but you 
need it as part of our existing LOP network.

Select the rendergeometrysettings node and press Cmd-C to copy it.

03 Navigate back to the destruction_stage LOP network and 
press Cmd-V to paste it into the network. Wire it just 

under the fireball reference node. 

This node does two things. First it sets up velocity motion blur on 
the fireball then it uses the volume to help light the shot.

01 Set the Persp view menu back to Houdini GL. In the 
Network View press tab > Reference then click to add 

a reference node. Next to Reference File, click on the File Chooser 
and find the pyrofx_fireball.usd file. Rename the node to fireball. Set 
the Primitive Path to /fx/$OS.

Feed this node into the original merge node. Alt click on the 
connecting wire to add a dot and move the dot to the lower right. 
With the Display Flag on the Karma node, scrub to around frame 
204 to see the explosion.

PART ELEVEN
Render the PyroFX
To complete the shot, add the fireball USD file then assign the proper material. Next, you will set up another camera to create 
a wide angle shot of the explosion and then render out the two sequences to achieve the final sequence. You can then preview 
the results using the Mplay image viewer. 
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07 On the Karma node, set Valid Frame Range to Render 
Frame Range. RMB-click on the End value which shows 

240 and select Delete Channels. Change the End value to 210.

You will use the animated camera for the first 210 frames then cut 
to a different camera for the last 30.

06 Add Prune node to the network and wire it just under 
the rendergeometrysettings node. Under Pruning Options, 

set Prune to $F<201. 

The fireball at frame 200 was poking through the bomb geometry 
and this will delay the explosion for one extra frame.

05 On the assignmaterial node, add another material 
listing and from the Scene Graph drag /fx/fireball to 

the Primitives section then click on the Material Path arrow and 
choose Pyro_Shader.

Set the Persp view menu back to Karma.  

08 Set the Persp view menu back to Houdini GL.  In the 
Network view, Alt-drag on the karmarendersettings and 

usdrender_rop nodes to the right. Set its Display Flag.

09 Tumble in the Scene view to get a new camera angle 
that is looking down on the explosion from above. Press 

the Ctrl key and click on the Camera tool in the LOP Lights and 
Cameras shelf. 

Set its Primitive Path to /cam/$OS and its name to cam2. 
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10 Lock the Camera to View and tweak the viewpoint to get 
the shot you are looking for. Check it at various points 

between frame 210 and 240. Turn the Lock the Camera to View 
option off when you are ready.

11 Move the cam2 node up above the karmarendersettings2 
node. On the usdrender_rop2 node, change the Start and 

End to 211 and 240 then change the camera to point to /cameras/
cam2.

Select the first karmarendersettings node and make sure that its 
camera is set to /cam/cam1. Otherwise the node will not render 
since the default camera1 isn't in our scene.

Select both usdrender_rop nodes, and change the Output picture to: 
$HIP/render/bomb/destruction_fx_$F2.exr

12 Select the usdrender_rop1 node. Click on the Render to 
Disk button. Repeat for usdrender_rop2.

Go to the Render menu and select MPlay > Load Desk Files. Go to 
the render/bomb directory and select the image sequence then click 
Load. This will play the images as a single animation.
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CONCLUSION
You have now built a destruction shot using  
particles, rigid body dynamics and Pyro FX. You 
built the complete project from scratch and have 
experienced many of the tools and techniques 
that Houdini artists use on a daily basis. 

You have also had a chance to bring your 
work into Solaris where you used USD to set 
up the scene graph for rendering to Karma. 

Now you can take these skills and begin 
exploring your own Destruction FX shots. 


